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1 Getting Started

1.1 Welcome to Lotto Pro

Unlike many other lottery programs that simply generate random numbers, Lotto Pro picks the best
numbers to play based on a statistical analysis of previous drawings. Lotto Pro helps you to play the
lottery with control, not guesswork. 

The numbers that Lotto Pro picks are called Smart numbers. When you play Smart numbers, the
program does all the work for you. There is no need for you to analyze any statistical information.

The program works with all lotteries; Pick 3, Pick 4, Pick 5, Pick 6, Keno, Powerball, Cash 4 Life and
more.

Lotto Pro also has many statistical charts and graphs. Once you become familiar with the program, you
may want to play your own numbers, based on the data from the charts and graphs. When you play

your own numbers, these numbers are called Favorite numbers. 

The following statistical charts are included with Lotto Pro:

Number Statistics Chart

Drawing Summary Chart

Skip and Hit Chart

Hit Sequence Chart

Repeating Pairs Chart

Repeating Triples Chart

The following statistical graphs are included with Lotto Pro:

Frequency Graph

Drawing Summary Graph

Skip and Hit Graph

Hit Sequence Graph

Lotto Pro also allows you to play strictly Random numbers. This option is included mainly so that

you compare random results to results obtained from using Smart or Favorite numbers.

Lotto Pro gives you two choices as to how your lottery tickets are created. You can select a wheeling
system to generate your tickets or you can specify how many tickets to create. A large selection of

Abbreviated, Full and Key Number wheeling systems are included with the program. 

Once your tickets have been created, you can apply filters to the tickets based on the sum, number of
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odd and even numbers or by Low/High number ratio. The program checks your lottery tickets for winning
matches, and includes an option to record your winnings.

The QuickStart in this section shows you how to how to quickly get started using Lotto Pro to play the
lottery with control, not guesswork.

1.2 System Requirements

Lotto Pro runs on computer systems meeting these requirements:

486 DX 66MHz or higher PC, running Windows 95/98/ME/NT/2000/XP/Vista/Windows 7.

10 MB RAM or higher.

7 Megabytes free hard disk space.

VGA display or higher (256 colors or more).

1.3 Installing Lotto Pro

1. Be sure that your system meets all of the system requirements for running Lotto Pro.

2. Be sure that all other open program are closed down.

3. If you have enough available space on your C drive, recommend that you install Lotto Pro in the
default location of c:\program files\windows lotto pro 2000.

1.4 Starting Lotto Pro

Double-click on the Lotto Pro icon on your desktop or from the Start menu select Programs|Lotto Pro|
Lotto Pro.
 

1.5 QuickStart

Follow the instructions below to start using Lotto Pro right away. The steps should be performed in the
order listed. Please refer to the other chapters in this help file for more detailed information.

To open your lottery: On the Open Drawing File page, click on your state or country. Click on the
name of the lottery you want to play. Click the Open button.
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To update your lottery file with the latest drawings: On the Add, Modify or Delete Drawings page,
click the Add button and enter the numbers drawn for the date displayed. Click the Save button.
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To create your lottery tickets: Click on the Tickets button and then click on Create Smart Number
Tickets. Click the Next button. Select a wheeling system and click the Next button. Click the Next
button again. Click the Save Tickets button on the toolbar to save the resulting tickets. Click the
Print Tickets button on the toolbar to print the tickets.
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To check your lottery tickets: Click on the Winnings button and then click on Check for Winning
Tickets. Click on the ticket filename that you saved in the previous step and then click the Open
button. Select the drawing date you want to compare the tickets with and click the Next button. The
number of matches is displayed in parenthesis for each ticket. Click on the Print Tickets button in the
toolbar to print the results.
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To record your winnings: Click on the Winnings button and then click on Record Winnings. Select
a winnings file to open and click the Open button. Click the Add button and enter the date, comment
and amount won or lost. Click the Save button.
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1.6 Using Lotto Pro

Welcome to the Lotto Pro Help system. Lotto Pro provides you with online Help for every task and
function. Press the F1 key or click on the Help button to display help for any screen you are on. 

Here is a guide to the conventions used in this Help system:

Click the Contents tab to browse through topics by category.

Click the Index tab to see a list of index entries; either type the word you're looking for or scroll
through the list.

Click the Search tab to search for words or phrases that may be contained in a Help topic.

1.7 How to Register Lotto Pro

Registration Cost:

The cost to register Lotto Pro is only $29.95. The program is also available on CD-ROM for an additional
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charge.

How to Register:

Order Lotto Pro securely online from our order page at http://www.windowslotto.com/
purchase_windows_lotto_pro.html.

http://www.windowslotto.com/purchase_windows_lotto_pro.html
http://www.windowslotto.com/purchase_windows_lotto_pro.html
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2 Working with Lottery Drawing Files

2.1 Opening a Lottery Drawing File

You must open a drawing file prior to performing any activities in Lotto Pro. There are several ways to
open a drawing file.

To open a drawing file that has never been opened before:

1. Click on the Drawings button or the File menu (shortcut CTRL+O) and then click Open Drawing
File.

2. If you are playing a lottery outside of the United States, you should select "Other Countries". 

3. Click on the state or country where your lottery is located.

4. Click on the lottery that you want to open.

5. Click the Open button.

To open a drawing file that has been previously opened:
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Each time you open a drawing file, it's filename is displayed at the bottom of the File menu. The File
menu displays the last 9 previously opened filenames. You can quickly open a previously opened
drawing file simply by clicking on it's filename.

To automatically open a drawing file when you start Lotto Pro:

1. Click on the Drawings button or File menu (shortcut CTRL+O) and then click Open Drawing File.

2. If you are playing a lottery outside of the United States, click on United States to remove the check
mark.

3. Click on the state or country where your lottery is located.

4. Click on the lottery that you want to open.

5. Click on Automatically load selected lottery at startup.

6. Click the Open button. Now, whenever you start Lotto Pro, the drawing file that you selected will
automatically load.

The name of the lottery that you opened is displayed in the title bar at the top of the screen. The total
drawings, last drawing date, Hot Number Cutoff and Drawing Cutoff are displayed in the status bar at the
bottom of the screen.

Note: A drawing file can also be opened by clicking on the Browse button, clicking on it's filename and
then clicking the Open button. You would normally use this method if you created a new drawing file
and its name was not displayed in the list of lotteries.

2.2 Adding a New Drawing

Related Topics: Modifying a Drawing, Deleting a Drawing, Printing Drawings

It is important to keep your drawing file(s) updated with the most recent drawings.
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To add a new drawing:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+A) and then click Add, Modify
or Delete Drawings.

2. Click on the Add button.

3. Check to make sure that the drawing date is correct. If the date is not correct, click in the Date box
and type the correct date, or click the arrow in the Date box and select a date in the calendar.

4. Enter the numbers that were drawn in the boxes below the date. If your cursor does not
automatically advance to the next box, press the Tab key.

5. Click the Save button after you have entered all the numbers for the drawing.

To download up-to-date drawings from our web site:

Double-click on the Update Lotto Drawing Files icon on your Windows Desktop. Select your state or
country and then click the Update button.

Note:

Lotto Pro can accept dates in different formats such as mm/dd/yyyy, dd/mm/yyyy or yyyy/mm/dd. The
default format is determined by your Windows default date settings. You can change the Windows
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settings by double-clicking on the Regional Settings icon in the Windows Control Panel, clicking on
the Date tab and entering the format in the Short date style box. Lotto Pro only accepts numbers for the
day, month and year so format such as dd/mmm/yyyy or mmm/dd/yyyy will result in an invalid date
format error.

Tips:

If you need to enter several drawings at one time, it is easier if you enter the drawings in chronological
order from the oldest date to the most recent date. The program will then automatically advance the date
to the correct date for each drawing when you click on the Add button.

If you need to enter drawings that are out of date sequence, it is easier if the Calculate Date box is not
checked. If the box is not checked, when you click on the Add button your cursor will automatically be
positioned in the Date box and the date will be blank.

After you press the Add button and before you press the Save button, you can press the Abort button to
cancel any entry that you have made.

2.3 Modifying a Drawing

Related Topics: Adding a New Drawing, Deleting a Drawing, Printing Drawings

At times it may be necessary to modify a drawing that was previously entered in the drawing file.
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To modify a drawing:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+A) and then click on Add,
Modify or Delete Drawings.

2. Click on the drawing that you want to modify in the drawing list. The date and numbers are displayed
in the boxes to the right of the drawing list.

3. If the date is not correct, click in the Date box and type the correct date, or click the arrow in the
Date box and select the correct date in the calendar.

4. If the numbers for the drawing are not correct, click on the boxes with the incorrect numbers and
type the correct numbers.

5. Click the Save button to save your changes.

2.4 Deleting a Drawing

Related Topics: Adding a New Drawing, Modifying a Drawing, Printing Drawings

At times it may be necessary to delete a drawing that was previously entered in a drawing file.
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To Delete a drawing:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+A) and then click on Add,
Modify or Delete Drawings.

2. Click on the drawing that you want to delete in the drawing list. 

3. Click on the Delete button.

4. Click on the Yes button when you are asked to confirm the deletion.

Tip:

You can also use the Next and Previous buttons to select a drawing in the Drawing list.

2.5 Printing Drawings

Related Topics: Adding a New Drawing, Modifying a Drawing, Deleting a Drawing
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You can preview or print all drawings in your drawing file, or specify a range of drawings to print.

To preview and print all the previous drawings:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+A) and then click on Add,
Modify or Delete Drawings.

2. Click on the Print button on the toolbar.

3. Click the OK button in the Print Options dialog.



Working with Lottery Drawing Files 21

Copyright © 2015 Data Solutions

4. Click on the OK button in the Drawing List Setup dialog. The Drawing list is displayed in the Drawing
List Preview window.

5. Click on the Next Page or Prev Page buttons to view other pages of the Drawing list.
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6. Click on the Zoom In or Zoom Out buttons to enlarge or shrink the size of the page.

7. Click the Zoom Page Width or Zoom Whole Page buttons to view the entire page width or the full
page in the window.

8. Click on the Print button to print the Drawing list.

9. Click the Done button to close the Preview window.

To preview and print a range of drawings:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+A) and then click on Add,
Modify or Delete Drawings.

2. Click on the Print button on the toolbar.

3. Select Range in the Print Options dialog.

4. Click on the From and To boxes and change the values to the desired draw range. To determine the
draw number for a particular drawing, click on the drawing in the drawing list. The draw number for
that drawing is displayed above the Date box.

5. Click the OK button in the Print Options dialog.
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6. Click on the OK button in the Drawing List Setup dialog. The Drawing list is displayed in the Drawing
List Preview window.

7. Click on the Next Page or Prev Page buttons to view other pages of the Drawing list.

8. Click on the Zoom In or Zoom Out buttons to enlarge or shrink the size of the page.

9. Click the Zoom Page Width or Zoom Whole Page buttons to view the entire page width or the full
page in the window.

10. Click on the Print button to print the Drawing list.

11. Click the Done button to close the Preview window.

Tip:

If you don't want to preview the drawing list before printing, select the Printer option in the Drawing List
Setup dialog.

2.6 Searching Previous Drawings

Lotto Pro allows you to search all or a portion of your drawing file for numbers that were previously
drawn. Up to 36 numbers can be searched for at a time and you can specify a minimum number of hits
per ticket to display.
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To search all the previous drawings:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+E) and then click on Search
Previous Drawings.

2. Make sure the All option is selected for Drawings.

3. Type the numbers you want to search for in the boxes. Do NOT enter duplicate numbers.

4. Set the value for the Minimum number of hits per ticket to search for. 

5. Click on the Search button. A list of drawing dates that match your search numbers is displayed.
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6. Click on the Summary drop down list to display a summary of the search results.

7. Click on the Print button on the toolbar to preview or print the search results.

8. Click on the Search Again button on the toolbar to search with another set of numbers.
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To search a range of the previous drawings:

1. Click on the Drawings button or the Drawings menu (shortcut CTRL+E) and then click on Search
Previous Drawings.

2. Select the Range option for the Drawings.

3. Click on the From and To boxes and change the values to the desired draw range. To determine the
draw number for a particular drawing, click on the drawing in Add, Modify or Delete Drawings. The
draw number for that drawing is displayed above the Date box.

4. Type the numbers you want to search for in the boxes. Do NOT enter duplicate numbers.

5. Set the value for the Minimum number of hits per ticket to search for. 

6. Click on the Search button. A list of drawing dates that match your search numbers is displayed.

7. Click on the Summary drop down list to display a summary of the search results.

8. Click on the Print button on the toolbar to preview or print the search results.

9. Click on the Search Again button on the toolbar to search with another set of numbers.

Tip:
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Click the Reset button to clear the numbers entered from a previous search.

2.7 Creating a New Drawing File

Whenever a state or country starts a new lottery, or changes an existing lottery, it is usually necessary
to create a new drawing file.

Data Solutions provides up-to-date files for all U.S. and Canadian lotteries. Whenever a new lottery game
is introduced, you will be able to download the new drawing file .

There will also be a Lotto Pro program change that adds the name of the new game to the Open Drawing
File page. You should use the Check for Program Update menu option in the program Help menu to
check for a program update. There is no charge for the update if you download it from our web site.

To create a new drawing file:

1. From the File menu, select New|Drawing File. The New Drawing File dialog is displayed.

2. Select the Game Type for the new game.

3. Enter a description of the new game in the description box. This description appears in the main
title bar of Lotto Pro when you open the new game.

4. Select the country where the new game is located.

5. If the new game is located in the United States, and it is not a multi-state game, select the state
where the game is located. 

6. If the new game is an international game and your country is not listed, select Other as the country.

7. Enter the number of numbers drawn in the new game in the Numbers Drawn box. If the new game
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has a bonus number, be sure to include the bonus number(s) in the total.

8. If the new game has a bonus number(s), enter the number of bonus numbers in the Bonus
Numbers box.

9. Enter the highest number drawn in the Highest Number box.

10. Enter the lowest number drawn in the Lowest Number box.

11. Click on the More Game Info tab.

12. Click on the days of the week that the new game is drawn on. This information is required so that
the program can automatically compute the next drawing date when adding a new drawing.

13. If the new game has a bonus number(s), click on the Bonus Info tab. Select the number of regular
number matches necessary for the bonus number to count. If the new game uses a different set of
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balls for the bonus number, click on the Allow Duplicates box. Enter the highest number allowed
for the bonus number in the Highest Number Allowed box.

14. Click on the Lottery Commission tab. This optional tab allows you to add information pertaining to
the Lottery commission for the new game.

15. Click OK to save the information pertaining to the new game, open the new game, and close the
New Drawing File dialog box.

Important:

If you created a new drawing file for an International game and selected Other as the country, you can
open the file by selecting Other as the country in the Open Drawing File page.

If the new lottery name does not appear on the Open Drawing File page, click on the Browse button. A
list of drawing filenames is displayed. The drawing filenames start with two letters corresponding to the
abbreviation for the state or country. The numbers that follow indicate number of numbers picked and the
highest number. For example, the Florida Lotto file is named FL649.DBF. Select the new drawing
filename and click the Open button to open the drawing file.

2.8 Deleting a Drawing File

You may want to delete lottery drawing files that you don't use to free up space on your hard drive.
Deleting a drawing file removes the file from your hard disk. However, it does not remove the lottery from
the Open Drawing File list. 



Lotto Pro Help30

Copyright © 2015 Data Solutions

To delete a drawing file:

1. Make sure that the drawing file that you want to delete is not open.

2. From the File menu, select Delete Drawing File. A list of drawing files that have been installed is
displayed. The drawing files start with two letters corresponding to the abbreviation for the state or
country. The numbers that follow indicate number of numbers picked and the highest number. For
example, the Florida Lotto file is named FL649.DBF.

3. Select the drawing file that you want to delete.

4. Click the Open button. A confirmation message is displayed.
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5. Click the Yes button to delete the drawing file.

Note:

Whenever a lottery discontinued, we remove the lottery from Open Drawing File and release a program
update. You should use the Check for Program Update menu option in the program Help menu to
check for a program update. There is no charge for the update if you download it from our web site.

2.9 Editing Lottery Information

After a drawing file has been created, you can edit certain information in the file, such as the days of the
week the game is drawn on. Some information cannot be edited such as Game type, Country, State,
Numbers Drawn, Bonus Numbers, Highest Number and Lowest Number. If a lottery game changes the
number of numbers drawn, highest number, or bonus number, it is necessary to create a new drawing
file, rather than modifying the old game.

To edit lottery information:

1. Open the Drawing file whose information you want to edit.

2. From the Edit menu, select Lottery Info.

3. Click on the Description box to change the name of the lottery game. The description appears in
the main title bar of Lotto Pro when you open the game.
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4. Click on the More Game Info tab to change the days of the week the game is drawn on.

5. If the game has a bonus number, click on the Bonus Info tab to change information pertaining to the
bonus number.
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6. Click on the Lottery Commission tab to change information pertaining to the lottery commission.
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3 Creating Your Lottery Tickets

3.1 Overview

Lotto Pro can generate lottery tickets with three different categories of numbers; Smart numbers,
Favorite numbers and Random numbers.

We recommend that if you are just learning to use Lotto Pro that you create your tickets using Smart
numbers. The program does all the work for you, and all your tickets will contain numbers that have the
best statistical chance of hitting.

Once you are more experienced interpreting the charts and graphs in the Lotto Pro, you may want to
play your own Favorite numbers, or a combination of Smart and Favorite numbers. 

We don't recommend that you play tickets generated with Random numbers. The option is included
mainly so that you compare random results with results obtained from playing Smart or Favorite
numbers.

When you generate tickets using any of the three categories of numbers you have two choices as to
how the tickets are generated; generate the tickets using the wheeling system of your choice, or
generate the number of tickets that you specify. 

In most cases it is better to generate your tickets with one of the wheeling systems. When you play a 
wheeling system, you are guaranteed a prize if a portion of the numbers you play match the actual
numbers picked. There is no such guarantee when create your tickets using the other method. Your
overall winnings are normally larger when you play a wheeling system because you will have several
tickets with winning matches. 

You normally choose a wheeling system based on how much you can afford to spend and the prize
guarantee associated with the system. If you can only afford to play a small number of tickets, you can 
apply filters to your lottery tickets to eliminate tickets with unlikely number combinations.

3.2 Creating Smart Number Tickets by Selecting a Wheeling
System

Related Topics: Why Use Wheeling Systems, Creating Your Own Smart Number Tickets

If you are just learning to use Lotto Pro, we recommend that you play Smart numbers until you have
more experience interpreting the charts and graphs. The program does all the work for you, and all your
tickets will contain numbers that have the best statistical chance of hitting.

In most cases, it is better to create your tickets by selecting a wheeling system. For more information
on the benefits of using wheeling systems, refer to the topic Why Use Wheeling Systems.
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To create Smart number tickets using a wheeling system:

1. Click on the Tickets button or the Tickets menu and select Create Smart Number Tickets
(CTRL+S). The option to Generate tickets by selecting a wheeling system is selected by
default.

2. If you have opened the Powerball, California SuperLotto Plus, Florida Mega Money or UK
Thunderball game, you will see a list of bonus numbers with the number of times the number was
drawn in the last 50 drawings and the date the number was last drawn. By default, the number at the
top of the bonus frequency list is checked and will appear on all tickets generated as the bonus
number. If you would like to play other bonus numbers on your tickets, simply place a check mark
next to the numbers you want to play.
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3. Click the Next button. A list of Abbreviated wheeling systems is displayed for the lottery that you
have open. Each wheeling system in the list shows you how many numbers are used, how many
tickets are created, the prize guarantee and the file name. A prize guarantee of 5/6 means that if 6
of the numbers played are correct, you are guaranteed to have at least one ticket with 5 matches.

4. If you select the Full option for the Wheel Type, a list of Full wheeling systems is displayed. This
option is not available if you are playing a Pick-3 or Pick-4 game.

5. If you select the Additional Abbreviated Wheels option for the Wheel Type, a list of additional
abbreviated wheeling systems is displayed. If you select the Key Number Wheels option for the
Wheel type, a list of Key number wheeling systems is displayed. These two options are only
available if you have opened a Pick-5, Pick-6 or Pick-7 lottery game.

6. Select a wheeling system to play. When selecting a wheeling system, you should consider the
number of numbers played, the prize guarantee and the number of tickets generated.



Lotto Pro Help38

Copyright © 2015 Data Solutions

7. Click the Next button. A list of Hot, Prior, Cold and Due numbers is displayed. The Hot number list
displays the number of times a number was drawn in the last x number of drawings, with x being
equal to the setting for the Hot Number Cutoff. The Prior number list shows the numbers that were
drawn in the last drawing and how many times the numbers were drawn in the last x (Hot Number
Cutoff) drawings. The Cold number list displays numbers that were not drawn in the last x (Hot
Number Cutoff) drawings and how many drawings it has been since the number was last drawn. The 
Due number list displays numbers that were not drawn in the last x (Hot Number Cutoff) drawings
and whose frequency is in the upper 1/3 of the Frequency list.

8. The program places a check mark next to the numbers it recommends to play. This
recommendation is based on an analysis of the last 50 drawings (or whatever value the Drawing
Cutoff is set at). If you would prefer to play other numbers, simply uncheck the numbers you don't
want to play and check the ones you do. The total numbers checked must equal the number of
numbers in the wheeling system that you selected. If you are playing a Pick-3 or Pick-4 daily game
and you check less numbers than the number of numbers in the wheeling system, some of your
tickets will have repeating numbers.
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9. Click the Next button. The program substitutes your numbers into the wheeling system that you
selected and displays the resulting tickets. If you are playing Powerball, Florida Mega Money or the
Uk Thunderball game, the bonus number(s) are displayed in the right hand column of the ticket list.
The prize guarantee for the wheeling system and the numbers played are displayed below the ticket
list.

10. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

11. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

12. Click on the Save Tickets button on the toolbar.

13. Type a name for the ticket file in the File Name box. Do not change the Save In box.

14. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

15. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.
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Tip:

Your bet slips will be easier to fill out if the Sorted box is checked. When the box is checked, all tickets
will display the numbers in chronological order from the lowest number to the highest number.

3.3 Creating Your Own Smart Number Tickets

We recommend that you only use this option when you want to play a small number of tickets. It better
to create Smart number tickets by selecting a wheeling system if you can afford to play more tickets.

To create your own Smart number tickets:

1. Click on the Tickets button or the Tickets menu and select Create Smart Number Tickets (
CTRL+S).

2. Select the option Create your own smart number tickets.
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3. Enter the number of smart number tickets your want to create.

4. If you have opened the Powerball, California SuperLotto Plus, Florida Mega Money or UK
Thunderball game, you will see a list of bonus numbers with the number of times the number was
drawn in the last 50 drawings and the date the number was last drawn. By default, the number at the
top of the bonus frequency list is checked and will appear on all tickets generated as the bonus
number. If you would like to play other bonus numbers on your tickets, simply place a check mark
next to the numbers you want to play.

5. Click the Next button. Boxes display how many Hot, Prior, Cold and Due numbers will be selected
for each ticket. Next to each box a percentage is displayed that was derived from a statistical
analysis of the last 50 drawings (or whatever value the Drawing Cutoff is set at).

6. If you wish to change any of the values displayed, click on one or more of the boxes and enter a new
value. The total for all the boxes must equal the number of numbers drawn in the lottery.
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7. Click on the Next button to view your smart number tickets. If you are playing Powerball, Florida
Mega Money or the Uk Thunderball game, the bonus number(s) are displayed in the right hand
column of the ticket list.

8. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

9. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

10. Click on the Save Tickets button on the toolbar.

11. Type a name for the ticket file in the File Name box. Do not change the Save In box.

12. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

13. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.

Tip:
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Your bet slips will be easier to fill out if the Sorted box is checked. When the box is checked, all tickets
will display the numbers in chronological order from the lowest number to the highest number.

Notes:

The numbers picked for Smart numbers will be different each time. This is necessary so that all your
tickets contain different  numbers. However, the percentage of Hot, Prior, Cold and Due numbers picked
will always be the same each time.

3.4 Creating Favorite Number Tickets by Selecting a Wheeling
System

Related Topics: Why Use Wheeling Systems, Creating Your Own Favorite Number Tickets

You may want to play your own Favorite numbers once you feel comfortable interpreting the charts and
graphs in Lotto Pro.

In most cases, it is better to create your tickets by selecting a wheeling system. For more information
on the benefits of using wheeling systems, refer to the topic Why Use Wheeling Systems.

To create Favorite number tickets using a wheeling system:
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1. Click on the Tickets button or the Tickets menu and select Create Favorite Number Tickets (
CTRL+F).

2. The option to Generate tickets by selecting a wheeling system is selected by default.

3. If you have opened the Powerball, California SuperLotto Plus, Florida Mega Money or UK
Thunderball game, you will see a list of bonus numbers with the number of times the number was
drawn in the last 50 drawings and the date the number was last drawn. By default, the number at the
top of the bonus frequency list is checked and will appear on all tickets generated as the bonus
number. If you would like to play other bonus numbers on your tickets, simply place a check mark
next to the numbers you want to play.

4. Click the Next button. A list of Abbreviated wheeling systems is displayed for the lottery that you
have open. Each wheeling system in the list shows you how many numbers are used, how many
tickets are created, the prize guarantee and the file name. A prize guarantee of 5/6 means that if 6
of the numbers played are correct, you are guaranteed to have at least one ticket with 5 matches.

5. If you select the Full option for the Wheel Type, a list of Full wheeling systems is displayed. This
option is not available if you are playing a Pick-3 or Pick-4 game.

6. If you select the Additional Abbreviated Wheels option for the Wheel Type, a list of additional
abbreviated wheeling systems is displayed. If you select the Key Number Wheels option for the
Wheel type, a list of Key number wheeling systems is displayed.
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7. Select a wheeling system to play. When selecting a wheeling system, you should consider the
number of numbers played, the prize guarantee and the number of tickets generated.

8. Click the Next button. A series of boxes is displayed. The number of boxes corresponds to the
number of numbers in the wheeling system that you selected. Enter a favorite number in each of the
boxes. If necessary, use the Tab key to advance to the next box.
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9. Click the Next button. The program substitutes your favorite numbers into the wheeling system that
you selected and displays the resulting tickets. If you are playing Powerball, Florida Mega Money or
the Uk Thunderball game, the bonus number(s) are displayed in the right hand column of the ticket
list. The prize guarantee for the wheeling system and the numbers played are displayed below the
ticket list.

10. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

11. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

12. Click on the Save Tickets button on the toolbar.

13. Type a name for the ticket file in the File Name box. Do not change the Save In box.

14. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

15. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.
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Tip:

When you enter your Favorite numbers, enter them in chronological order, from lowest to highest. The
numbers on your tickets will then be displayed from lowest to highest, making it easier to fill out your bet
slips.

3.5 Creating Your Own Favorite Number Tickets

You may want to play your own Favorite numbers once you feel comfortable interpreting the charts and
graphs in Lotto Pro.

We recommend that you only use this option when you want to play a small number of tickets. It better
to create Favorite number tickets by selecting a wheeling system if you can afford to play more tickets.

To create your own Favorite number tickets:

1. Click on the Tickets button or the Tickets menu and select Create Favorite Number Tickets (
CTRL+F).
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2. Select the option Create your own favorite number tickets.

3. Enter the number of favorite number tickets your want to create.

4. Click the Next button. Your cursor is positioned in the first of a series of boxes at the bottom of the
ticket list.

5. Enter your favorite numbers for the first ticket in the boxes. Use the Tab key to advance to the next
box. If you are playing Powerball, California SuperLotto Plus, Florida Mega Money or the UK 
Thunderball game, the last box is for the bonus number.

6. Repeat the above step for all remaining favorite number tickets.

7. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

8. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

9. Click on the Save Tickets button on the toolbar.

10. Type a name for the ticket file in the File Name box. Do not change the Save In box.
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11. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

12. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.

Tip:

If you enter your Favorite numbers in chronological order from lowest to highest, it is easier to fill out
your bet slips.

3.6 Creating Random Number Tickets by Selecting a Wheeling
System

Related Topics: Why Use Wheeling Systems, Creating Your Own Random Number Tickets

The Random number tickets option is included so that you can compare random results with results
obtained by playing Smart or Favorite numbers.

In most cases, it is better to create your tickets by selecting a wheeling system. For more information
on the benefits of using wheeling systems, refer to the topic Why Use Wheeling Systems.
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To create Random number tickets using a wheeling system:

1. Click on the Tickets button or the Tickets menu and select Create Random Number Tickets (
CTRL+R). The option to Generate tickets by selecting a wheeling system is selected by default.
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2. Click the Next button. A list of Abbreviated wheeling systems is displayed for the lottery that you
have open. Each wheeling system in the list shows you how many numbers are used, how many
tickets are created, the prize guarantee and the file name. A prize guarantee of 5/6 means that if 6
of the numbers played are correct, you are guaranteed to have at least one ticket with 5 matches.

3. If you select the Full option for the Wheel Type, a list of Full wheeling systems is displayed. This
option is not available if you are playing a Pick-3 or Pick-4 game.

4. If you select the Additional Abbreviated Wheels option for the Wheel Type, a list of additional
abbreviated wheeling systems is displayed. If you select the Key Number Wheels option for the
Wheel type, a list of Key number wheeling systems is displayed. These two options are only
available if you have opened a Pick-5, Pick-6 or Pick-7 lottery game.

5. Select a wheeling system to play. When selecting a wheeling system, you should consider the
number of numbers played, the prize guarantee and the number of tickets generated.
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6. Click the Next button. The program substitutes Random numbers into the wheeling system that you
selected and displays the resulting tickets. If you are playing Powerball, Florida Mega Money or the
UK Thunderball game, the bonus number is displayed in the right hand column in the ticket list. The
prize guarantee for the wheeling system and the random numbers played are displayed below the
ticket list.

7. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

8. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

9. Click on the Save Tickets button on the toolbar.

10. Type a name for the ticket file in the File Name box. Do not change the Save In box.

11. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

12. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.
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3.7 Creating Your Own Random Number Tickets

The Random number tickets option is included so that you can compare random results with results
obtained by playing Smart or Favorite numbers.

To create your own Random number tickets:

1. Click on the Tickets button or the Tickets menu and select Create Random Number Tickets (
CTRL+R).

2. Select the option Create your own random number tickets.

3. Enter the number of random number tickets your want to create.
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4. Click the Next button to view your random number tickets. If you are playing Powerball, California
SuperLotto Plus, Florida Mega Money or the UK Thunderball game, the last number in each ticket is
the bonus number.

5. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

6. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

7. Click on the Save Tickets button on the toolbar.

8. Type a name for the ticket file in the File Name box. Do not change the Save In box.

9. Click the Save button. This saves your tickets to a ticket file so that you can later check your
tickets for winning matches.

10. You are asked if you want to eliminate unlikely tickets by applying filters to your tickets. Click on
Yes or No.
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3.8 Applying Filters to Your Lottery Tickets

If you are playing a large number of tickets, you may to bring the number of tickets closer to what your
budget allows by applying  filters that eliminate tickets with combinations of numbers that are not likely
to be drawn. 

Lotto Pro allows you to apply filters based on the sum of the numbers on each ticket, the number of odd
and even numbers per ticket, or the low/high number ratio per ticket. Statistics are given for the average
sum and average number of odd and even numbers for the last 50 drawings (or whatever the Drawing
Cutoff is set to) so that you can apply filters close to the statistical averages. 

To apply filters to your tickets:

1. Click on the Tickets button or the Tickets menu and select Apply Filters to Tickets (CTRL+P).
You can also apply filters when you create your tickets using Smart, Favorite or Random numbers
by answering 'Yes' to the filter question when you save your tickets.

2. If necessary, select a ticket file that you saved earlier and click the Open button. The tickets that
were saved previously are displayed in the ticket list.
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3. In the Sum Filter section, select the Range option. The Average Sum for the last 50 drawings (or
whatever the Drawing Cutoff is set to) is displayed below the Range option. You should try to keep
the From and To sum filters close to this average.

4. Click on the From box in the Sum Filter section and enter a value that is less than the Average
Sum.

5. Press the Tab key. The number of tickets displayed in the ticket list should decrease. It they do
not, keep increasing the From value until they do.

6. Your cursor should now be in the To box in the Sum Filter section. Enter a value that is greater
than the Average Sum and press the Tab key. The number of tickets displayed in the ticket list
should decrease again. If not, keep decreasing the To value until they do.

7. In the Odd Filter section, select the Range option. The Average number of odd numbers for the
last 50 drawings (or whatever the Drawing Cutoff is set to) is displayed below the Range option. You
should try to keep the From and To odd filters close to this average.

8. Click on the From box in the Odd Filter section and enter a value that is less than the average
number of odd numbers.

9. Press the Tab key. The number of tickets displayed in the ticket list should decrease. It they do
not, keep increasing the From value until they do.

10. Your cursor should now be in the To box in the Odd Filter section. Enter a value that is greater
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than the average number of odd numbers and press the Tab key. The number of tickets
displayed in the ticket list should decrease again. If not, keep decreasing the To value until they do.

11. You can also filter your tickets by low/high number ratio. The set of playing numbers is divided into
two: low and high numbers. With this filter you set a range of low and high numbers that you want to
accept in each ticket. Suppose that you are wheeling numbers from 1 to 49. Half of these are "Low"
numbers (1 to 24) and the other half are "High" numbers (from 25 to 49). For example, the following
combination 7 12 27 32 44 49 has 2 Low numbers (7 12) and 4 High numbers (27 32 44 49). To
apply the low/high number filter, click on the button with the ratio you want to apply.

12. To print your tickets directly on bet slips, click on the Print Tickets on Bet Slips button on the
toolbar. If this is the first time that you have printed bet slips, a Bet Slip Properties screen will be
displayed so that you can enter information pertaining to your bet slip. You should refer to the topic 
Printing Tickets on Bet Slips for more information. If your bet slips do not print correctly, you should
select Bet Slip Properties in the Edit menu and make any need corrections.

13. If you prefer to fill out your bet slips by hand, click on the Print Tickets on Paper button on the
toolbar.

14. Click on the Save Ticket File button on the toolbar. The File Name box should contain the
filename that was previously opened. If you would rather save the tickets to a new file, enter a
different filename.

15. Click on the Save button to save the changes to your tickets.

Tips:

You can manually delete tickets by highlighting the ticket you want to delete in the ticket list and
clicking the Delete button.

You can manually add tickets by clicking the Add button and entering the numbers in the boxes below
the ticket list.

You can quickly open another ticket file by clicking on the Open Ticket File button on the toolbar.

Note:

You can only enter whole numbers for the Sum and Odd number filters. Decimal values are not
accepted.

If you filter a set of tickets that were generated by a wheeling system, the prize guarantee for the
wheeling system is no longer valid.

3.9 Printing Tickets on Betslips

Lotto Pro allows you to print your tickets directly on lottery bet slips when you play Smart, Favorite or
Random numbers. You can also print on bet slips when you apply filters to your lottery tickets.

If this is the first time printing on bet slips, you may have to create a bet slip definition file with
information pertaining to the bet slip. You can also download bet slip definition files for some states from
our web site.

http://www.windowslotto.com/bet_slips.html
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The Bet Slip Properties screen can also be for testing and to make adjustments if your bet slips are not
printing correctly.
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To create a bet slip definition file:

Open the lottery you wish to print slips for and then select Bet Slip Properties in the Edit menu to
display the Bet Slip Properties screen. This screen will also be displayed if you attempt to print bet slips
before creating a definition file. The example bet slip above shows the information that must be entered
in the Bet Slip Properties screen.

A preview window on the right side of the screen allows you to see what you design looks like as you
enter the information. Use the Zoom In and Zoom Out buttons to optimize the display.

1. Select whether you want to use millimeters or inches for measurements. You can specify more
precise measurements if you select millimeters.

2. Enter the width of the bet slip in the Width of Bet Slip box.

3. Enter the number of panels across the bet slip in the Panels Across. The above example has one
panel across.

4. Enter the number of panels down the bet slip in the Panels Down box. The above example has five
panels down.

5. Enter the vertical distance from the first box in a panel to the same box in the next panel in the
Vertical Interval box.
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6. Enter the horizontal distance from the first box in a panel to the same box in the next panel (if any)
in the Horizontal Interval box. The above example has only one panel across, so there is no
horizontal interval.

7. Select whether the panels are ordered from top to bottom, or from right to left on the bet slip. In the
above bet slip, the panels run from top to bottom.

8. Enter the number of boxes across a panel in the Boxes Across box. The above example has 9
boxes across a panel.

9. Enter the number of boxes down a panel in the Boxes Down box. The above example has 6 boxes
down each panel.

10. On some bet slips, the first box in each panel is offset from where the other rows or columns start. It
this is the case, enter the number of boxes to skip in the first row or column before printing the first
box. In the above bet slip, the first box is not offset from the others, so the value for the 1st Row
Offset is zero.

11. Enter the distance from the top of the bet slip to the first box in the Boxes Top Margin box.

12. Enter the distance from the right side of the bet slip to the first box in the Boxes Right Margin box.

13. Enter the width of one box in the Box Width box.

14. Enter the height of one box in the Box Height box.

15. Enter the vertical distance from the top of one box to the top of the box below it in the same panel in
the Vertical Interval box.

16. Enter the horizontal distance from the right side of one box to the right side of another box in the
same panel in the Horizontal Interval box.

17. Determine how the boxes are numbered in each panel. In the above bet slip, the boxes are
numbered from the top of the panel down to the bottom. However, some bet slips are numbered
across the panel from right to left or from left to right.

18. Click the OK button to create/save your definition file.

To print a test bet slip:

1. Insert your bet slips into your printer. Make sure that you insert the slips vertically with the first
panel down (into the printer). It is best if you place a stack of bet slips in your printer because the
slips are less likely to shift position.

2. Click the Test button to print a test bet slip.

3. If the marks do not align with all the boxes, you will have to make changes to the measurements
and then print another Test bet slip. You should continue testing until all the marks are aligned with
the boxes.

4. Click the OK button to save any changes that you made.
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3.10 Deleting a Ticket File

Use this option to delete old ticket files that are no longer needed. Ticket files are created when you
save Smart, Favorite or Random number tickets.

To delete a ticket file:

1. Click on the File menu and select Delete Ticket File.

2. Select the ticket file that you want to delete and click on the Open button.
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3. Click on the Yes button when asked if you want to delete the file.

4. Click OK when you receive the confirmation message that the file has been deleted.



Part

IV



Checking Your Lottery Tickets 65

Copyright © 2015 Data Solutions

4 Checking Your Lottery Tickets

4.1 Checking Your Tickets for Matches

Before you check your tickets, you should ensure that your drawing file is up-to-date. Lotto Pro will
check the lottery tickets that you have saved with any drawing in your drawing file. 

In order to check your tickets, you must first open the lottery for which the tickets were created. For
example, if you previously saved some tickets for the Powerball game, you must open the Powerball
drawing file prior to checking the tickets.

To check your lottery tickets:

1. Click on the Winnings button or the Winnings menu and select Check for Winning Tickets (
CTRL+C).

2. Select a ticket file that you previously saved and click the Open button. A list of the previous
drawing dates and the numbers drawn for that date is displayed.

3. Select the drawing date that you want to compare your tickets with.

4. Click the Next button. The tickets that you previously saved are displayed in the ticket list. To the
right of each ticket is a number in parentheses that indicates how many matches the ticket had.
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5. Click on the down arrow in the Summary box to display a summary of matches for all tickets.

6. You can display only tickets that have a certain number of matches by changing the value entered in
the Minimum Number of Matches to Display box. For example, if you enter 3 in the box, only
tickets with 3 or matches will be displayed in the ticket list.

7. Click on the Print Tickets button in the toolbar to print the results.

8. To quickly check another ticket file, click the Previous button and then click on the Open Ticket
File button on the toolbar.

4.2 Recording Your Winnings

It is important to keep a record of your winnings and losses playing the lottery. The information may be
required for tax purposes, plus you can tell at a glance how well your playing strategy is working. 

We recommend that you create a new winnings file at the beginning of each year. One empty winnings
file is included with Lotto Pro (filename LOTOWINS.DBF). 
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To record your winnings:

1. Click on the Winnings button or the Winnings menu and select Record Winnings (CTRL+W).

2. Select the winning file LOTOWINS.DBF or another winnings file that you previously created. Click
on the Open button.
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3. Click on the Add button.

4. Enter the date in the Date box. You can also click on the arrow in the Date box to select a date
using the calendar.

5. Press the Tab key to advance to the Comment box. The Comment box is normally used to record
how you created your tickets (Smart, Favorite or Random) or what wheeling system you used. Enter
a comment.

6. Press the Tab key to advance to the Amount Won box. Enter the amount won for the date entered.

7. Press the Tab key to advance to the Amount Lost box. Enter the amount lost for the date entered.

8. Click on the Save button to save your entry. The program will total all your entries and display the
results under Total Won and Total Lost.

9. Click the Print Winnings button on the toolbar to print your entries.

Tip:

When adding a new entry, you can click on the Abort button any time before you click on the Save
button to cancel the entry.

Note:
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To delete an entry, select the entry and then click on the Delete button. Click on the Yes button when
you are asked to confirm the deletion.

4.3 Creating a New Winnings File

We recommend that you create a new winnings file at the beginning of each year. One empty winnings
file is included with Lotto Pro (filename LOTOWINS.DBF).

To create a new winnings file:

1. Click on the File menu and select New|Winnings File.

2. Enter a name for the winnings file in the File name box. Do not change the Save in box. 
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3. Click OK when you receive a message that the winnings file has been created.

Tip:

If you are going to create a new winnings file each year, it is a good idea to include the year in the
filename so that you can later easily identify what year the file is for.

4.4 Deleting a Winnings File

Use this option to delete winnings files that are no longer needed.

Winnings files are used to record your Lottery winnings and losses.
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To delete a winnings file:

1. Click on the File menu and select Delete Winnings File.

2. Select the winnings file that you want to delete and click the Open button.

3. Click the Yes button when asked to confirm the deletion.
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4. Click the OK button when you get a message that the file has been deleted.
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5 Interpreting the Statistical Charts

5.1 Number Statistics Chart

Related Topics: Frequency Graph

To view the Number Statistics chart, click on the Statistics button or the Statistics menu and select
Number Statistics Chart/Graph. 

The Number Statistics chart shows the following information:

Number Frequency

Hit Index

Hot numbers

Prior numbers

Cold numbers

Due numbers
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Average number of draws per number

The number of drawings used to derive the statistics in the chart is dependent on the setting of the 
Drawing Cutoff. 

In the Frequency list, the number in parentheses next to each number indicates how many times the
number has been drawn in the number of previous drawings indicated by the Drawing Cutoff. The date
indicates the date the number was last drawn. If a "*" appears to the left of a number, it indicates that
the number is a Prior number. The numbers are displayed from the highest frequency down to the
lowest.

In the Hit Index list, the number in parentheses is the Hit Index. Numbers are displayed from the
Highest Hit Index down to the lowest.

In the Hot number list, the number in parentheses indicates the number of times a number has been
drawn in the number of drawings indicated by the Hot Number Cutoff. A "*" to the left of a number
indicates that it is a Prior number. Hot numbers are displayed from those that have been picked the
most often down to the least often.

In the Cold number list, the number in parentheses indicates the number of drawings since a number
was last drawn. The Hot Number Cutoff determines whether a number is Hot or Cold. If a "#" appears to
the left of a number, it indicates that the number is a Due number. Cold numbers are displayed from
coldest down to the least cold.

If you are playing a lottery that has a bonus number, a Bonus Number Options button is displayed on
the toolbar.

When you click the Bonus Number Options button, the Bonus Number Options dialog is displayed
with three options for bonus numbers. The default setting is to show statistics for the regular numbers
only. The second option is to show statistics for regular numbers and bonus numbers. The last option is
to show statistics for the bonus number only.

For example, if you are playing the Powerball game, you could get statistics on just the Powerball by
selecting the third option.

Click on the Print button in the toolbar to preview or print the Number Statistics chart.

Click on the Frequency Graph button on the toolbar to view the Frequency graph.

5.2 Drawing Summary Chart

Related Topics: Drawing Summary Graph

To view the Drawing Summary chart, click on the Statistics button or the Statistics menu and select
Drawing Summary Chart/Graph.
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The number of drawings included in the Drawing Summary chart is dependent on the setting of the 
Drawing Cutoff. Each row in the chart represents one drawing, with the date of the drawing displayed in
the first column. Each drawing is analyzed to determine how many numbers are in each of the following
categories:

Number ranges in increments of 10

Hot numbers

Prior numbers

Cold numbers

Due numbers

Odd numbers

Even numbers

Sum of the numbers

Whether a number is considered Hot or Cold is dependent on the Hot Number Cutoff setting. 

At the bottom of the chart, averages and percentages are shown for all the above categories. When you
play Smart numbers, the program uses these percentages to pick your numbers. For example, if 50
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percent of the numbers picked in the last 50 drawings were Hot numbers, then half of the Smart
numbers picked will be Hot numbers.

If you apply filters to your lottery tickets, they should be close to the Averages displayed for odd and
even numbers and the sum of the numbers.

If you are playing a lottery that has a bonus number, a Bonus Number Options button is displayed on
the toolbar. 

When you click the Bonus Number Options button, the Bonus Number Options dialog is displayed
with three options for bonus numbers. The default setting is to show statistics for the regular numbers
only. The second option is to show statistics for regular numbers and bonus numbers. The last option is
to show statistics for the bonus number only.

For example, if you are playing the Powerball game, you could get statistics on just the Powerball by
selecting the third option.

Click on the Print button in the toolbar to preview or print the Drawing Summary chart.

Click on the Drawing Summary Graph button in the toolbar to view the Drawing Summary graph.

5.3 Skip and Hit Chart

Related Topics: Skip and Hit Graph

To view the Skip and Hit chart, click on the Statistics button or the Statistics menu and select Skip
and Hit Chart/Graph.
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The number of drawings used to derive the statistics in the chart is dependent on the setting of the 
Drawing Cutoff. 

The horizontal rows in the chart display the statistics for the numbers in the lottery. The number that
each row represents is displayed in the first vertical column on the left. Use the vertical scroll bar to view
rows that are not visible.

The other columns, numbered 0 to 24+, show the Skip and Hit frequency for each number. A number
that appears in the 00 column indicates how many times the number (in the far left column) was drawn
with no skips (back to back draws) in the last 50 drawings (or whatever value the Drawing Cutoff is set
to). 

A number in the 01 column represents how many times a number was drawn, skipped a drawing, and
was drawn again (1 skip). A number in the 02 column represents how many times a number was drawn,
skipped two drawings, and was drawn again (2 skips).

When interpreting the chart, you should look for the highest skip value for a number. The Skip and Hit
chart is normally used with the Hit Sequence Chart. From the Skip and Hit chart you can determine that
a number has a tendency of skipping a certain number of drawings before hitting again. You can then
look at the Hit Sequence chart to see how long it has been since the number last hit. If the skip
tendency is equal to the number of drawings since the last hit, it would be a good idea to play that
number now.

If you are playing a lottery that has a bonus number, a Bonus Number Options button is displayed on
the toolbar. 
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When you click the Bonus Number Options button, the Bonus Number Options dialog is displayed
with three options for bonus numbers. The default setting is to show statistics for the regular numbers
only. The second option is to show statistics for regular numbers and bonus numbers. The last option is
to show statistics for the bonus number only.

For example, if you are playing the Powerball game, you could get statistics on just the Powerball by
selecting the third option.

Click on the Print button in the toolbar to preview or print the Skip and Hit chart.

Click on the Skip and Hit Graph button in the toolbar to view the Skip and Hit Graph.

5.4 Hit Sequence Chart

Related Topics: Hit Sequence Graph

To view the Hit Sequence chart, click on the Statistics button or the Statistics menu and select Hit
Sequence Chart/Graph.

The Hit Sequence chart displays information for the last 25 drawings. If the Drawing Cutoff is set to a
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value less than 25, the chart will display information for the number of drawings that the cutoff is set to.

The horizontal rows in the chart represent the numbers in the lottery. The number that each row
represents is displayed in the first vertical column on the left. Use the vertical scroll bar to view rows that
are not visible. 

The other vertical columns represent the last 25 drawings and are numbered from 1 to 25, from right to
left. The most recent drawing is column 1. The chart should be read from right to left.

A "##" in the chart represents a hit for a regular number. For example, if a "##" appears in column 1, row
1, it indicates that the number 1 was drawn in the last drawing. 

If a number appears in a column, it represents how many drawings since the last hit. For example if the
number 5 appears in row 2, column 1, it means that the number 2 has not been drawn for 5 drawings.

If you are playing a lottery that has a bonus number, a Bonus Number Options button is displayed on
the toolbar.

When you click the Bonus Number Options button, the Bonus Number Options dialog is displayed
with three options for bonus numbers. The default setting is to show statistics for the regular numbers
only. The second option is to show statistics for regular numbers and bonus numbers. The last option is
to show statistics for the bonus number only.

If you select option 2 or 3 in the Bonus Number Options dialog, the chart will display "BB" to indicate a
bonus number hit.

The Hit Sequence chart is normally used with the Skip and Hit Chart. From the Skip and Hit chart you
can determine that a number has a tendency of skipping a certain number of drawings before hitting
again. You can then look at the Hit Sequence chart to see how long it has been since the number last
hit. If the skip tendency is equal to the number of drawings since the number last hit, it would be a good
number to play.

Click on the Print button in the toolbar to preview or print the Hit Sequence chart.

Click on the Skip and Hit Graph button in the toolbar to view the Hit Sequence graph.

5.5 Repeating Pairs Chart

To view the Repeating Pairs chart, click on the Statistics button or the Statistics menu and select
Repeating Pairs chart.
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The number of drawings used to derive the statistics in the chart is dependent on the setting of the 
Drawing Cutoff. 

The number of occurrences of repeating pairs are listed in the drop down box from the largest to the
smallest. Click on the down arrow to display other occurrences. The number in parentheses indicates
how many pairs were found for a particular occurrence. 

When you click on an occurrence, the pairs that were found for that number of occurrences are
displayed in the Pairs list on the right.

If you are playing a lottery that has a bonus number, an Include Bonus # box is displayed. If the box is
checked, bonus numbers are included with regular numbers when searching for repeating pairs.

Click on the Print button in the toolbar to preview or print the Repeating Pairs chart.

5.6 Repeating Triples Chart

To view the Repeating Triples chart, click on the Statistics button or the Statistics menu and select
Repeating Triples chart.
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The number of drawings used to derive the statistics in the chart is dependent on the setting of the 
Drawing Cutoff. 

The number of occurrences are listed in the drop down box from the largest to the smallest. Click on the
down arrow to display other occurrences. The number in parentheses indicates how many triples were
found for a particular occurrence. 

When you click on an occurrence, the triples that were found for that number of occurrences are
displayed in the Triples list.

If you are playing a lottery that has a bonus number, an Include Bonus # box is displayed. If the box is
checked, bonus numbers are included with regular numbers when searching for repeating triples.

Click on the Print button in the toolbar to preview or print the Repeating Pairs chart.
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6 Interpreting the Statistical Graphs

6.1 Frequency Graph

The Frequency graph displays information from the Number Statistics chart in bar graph format.

To view the Frequency graph, click on the Statistics button or the Statistics menu and select Number
Statistics Chart/Graph. Click on the Frequency Graph button in the toolbar.

The number of drawings used to derive the statistics in the graph is dependent on the setting of the 
Drawing Cutoff. 

The horizontal axis of the graph represents the numbers drawn in the lottery. The numbers are displayed
below the horizontal axis and in the boxes above the vertical bars.

The vertical axis has different color bars representing the following categories of numbers: 

Hot numbers

Prior numbers

Cold numbers
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Due numbers

A legend at the bottom of the graph associates each bar color with one of the above categories. 

The vertical height of each vertical bar represents the number of times a number has been drawn
(Number Frequency). The frequency value is read from the left vertical axis.

Click on the Print Preview button on the toolbar to view how the graph will appear before it is printed.
You can also change the page orientation, margins and graph detail.

Click on the Print button on the toolbar to print the graph. If you have a color printer, the graph will print
in color.

Click on the Copy to Clipboard button to copy the graph to the Windows clipboard. The graph can then
be pasted into any graphics program, using the Paste command in the graphics program.

Click on the Return to Number Statistics Chart button on the toolbar to view the Numbers Statistics
chart.

Tip: To make the graph larger and easier to read, click on the Maximize button in the upper right hand
corner of the graph window.

6.2 Drawing Summary Graph

The Drawing Summary graph displays information from the Drawing Summary chart in bar graph format.

To view the Drawing Summary graph, click on the Statistics button or the Statistics menu and select
Drawing Summary Chart/Graph. Click on the Drawing Summary Graph button in the toolbar.
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The number of drawings displayed in the graph is dependent on the setting of the Drawing Cutoff. 

The Drawing Summary graph displays 10 drawings at a time. The drawing dates are displayed on the
horizontal axis of the graph.

When you first open the graph, the last 10 drawings are displayed. To view drawings prior to the last 10,
click on the Previous Dates button on the toolbar. Click on the Next Dates button on the toolbar to
display newer drawings.

Each drawing date consists of different color vertical bars that represent the values of the following
categories in the Drawing Summary chart.

Number ranges in increments of 10

Hot numbers

Prior numbers

Cold numbers

Due numbers

Odd numbers

Even numbers
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The numerical value for a particular category can be determined by comparing the height of the bar to the
values on the vertical axis. 

A legend is displayed to the right of the graph that associates each color with one of the above
categories.

Click on the Print Preview button on the toolbar to view how the graph will appear before it is printed.
You can also change the page orientation, margins and graph detail.

Click on the Print button on the toolbar to print the graph. If you have a color printer, the graph will print
in color.

Click on the Copy to Clipboard button to copy the graph to the Windows clipboard. The graph can then
be pasted into any graphics program, using the Paste command in the graphics program.

Click on the Return to Drawing Summary Chart button on the toolbar to view the Drawing Summary
chart.

Tip: To make the graph larger and easier to read, click on the Maximize button in the upper right hand
corner of the graph window.

6.3 Skip and Hit Graph

The Skip and Hit graph displays information from the Skip and Hit chart in bar graph format.

To view the Skip and Hit graph, click on the Statistics button or the Statistics menu and select Skip
and Hit Chart/Graph. Click on the Skip and Hit Graph button on the toolbar.
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The number of drawings that are analyzed in the Skip and Hit graph is dependent on the setting of the 
Drawing Cutoff.

The horizontal axis of the graph represents the numbers drawn in the lottery, with 15 numbers being
shown at a time. 

When you first open the graph, information for numbers 1 to 15 is displayed. To view information for
numbers higher than 15, click on the Higher Numbers button on the toolbar. To view lower numbers,
click on the Lower Numbers button on the toolbar.

The graph has different color vertical bars representing the 25 skip categories (0 to 24). A legend to the
right of the graph associates each color with a skip category (0 to 24). The numerical value for a
particular category can be determined by comparing the height of the bar to the values on the vertical
axis. 

If a number has a vertical bar for the Skip 0 category, it's value indicates the number of times the number
was drawn with no skips (back to back). If a number has a vertical bar for the Skip 1 category, it's value
indicates the number of times that number was drawn, skipped a drawing, and was drawn again (1 skip).
When interpreting the graph, you should look for the highest skip value for a number. 

The Skip and Hit graph is normally used with the Hit Sequence Chart. From the Skip and Hit graph you
can determine that a number has a tendency of skipping a certain number of drawings before hitting
again. You can then look at the Hit Sequence chart to see how long it has been since the number last
hit. If the skip tendency is equal to the number of drawings since the number last hit, it would be a good
number to play.
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Click on the Print Preview button on the toolbar to view how the graph will appear before it is printed.
You can also change the page orientation, margins and graph detail.

Click on the Print button on the toolbar to print the graph. If you have a color printer, the graph will print
in color.

Click on the Copy to Clipboard button to copy the graph to the Windows clipboard. The graph can then
be pasted into any graphics program, using the Paste command in the graphics program.

Click on the Return to Skip and Hit Chart button on the toolbar to view the Skip and Hit chart.

Tip: To make the graph larger and easier to read, click on the Maximize button in the upper right hand
corner of the graph window.

6.4 Hit Sequence Graph

The Hit Sequence graph displays information from the Hit Sequence chart in bar graph format.

To view the Hit Sequence graph, click on the Statistics button or the Statistics menu and select Hit
Sequence Chart/Graph. Click on the Hit Sequence Graph button on the toolbar.
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The Hit Sequence graph displays information for the last 25 drawings. If the Drawing Cutoff is set to a
value less than 25, the chart will display information for the number of drawings that the cutoff is set to. 

The horizontal axis of the graph represents the numbers drawn in the lottery, with 15 numbers being
shown at a time.

When you first open the graph, information for numbers 1 to 15 is displayed. To view information for
numbers higher than 15, click on the Higher Numbers button on the toolbar. To view lower numbers,
click on the Lower Numbers button on the toolbar.

The vertical axis has different color bars representing hit categories (1 to 25). A legend to the right of the
graph associates each color with a hit category.

If a number has a vertical bar for the Hit 1 category, it indicates that the number was drawn in the last
drawing. If a number has a bar indicating the Hit 2 category, the number was drawn two drawings ago.
All regular numbers have a value of 2. 

If the lottery that you opened has a bonus number, any bonus numbers will have a value of 1. Bonus
numbers will only appear in the graph if you have selected the option to include bonus numbers with
regular numbers in the Hit Sequence chart. 

The Hit Sequence graph is normally used with the Skip and Hit Chart. From the Skip and Hit chart you
can determine that a number has a tendency of skipping a certain number of drawings before hitting
again. You can then look at the Hit Sequence graph to see how long it has been since the number last
hit. If the skip tendency is equal to the number of drawings since the number last hit, it would be a good
number to play.

Click on the Print Preview button on the toolbar to view how the graph will appear before it is printed.
You can also change the page orientation, margins and graph detail.

Click on the Print button on the toolbar to print the graph. If you have a color printer, the graph will print
in color.

Click on the Copy to Clipboard button to copy the graph to the Windows clipboard. The graph can then
be pasted into any graphics program, using the Paste command in the graphics program.

Click on the Return to Skip and Hit Chart button on the toolbar to view the Skip and Hit chart.

Tip: To make the graph larger and easier to read, click on the Maximize button in the upper right hand
corner of the graph window.
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7 Working with Wheeling Systems

7.1 Why Use Wheeling Systems?

Wheeling systems simplify the betting process, guarantee a cash prize when the numbers drawn appear
in your larger group of numbers wheeled, and maximize your payoffs through multiple ticket hits because
you play many combinations of the same numbers.

It can honestly be said that Wheeling reduces the odds against you! First, by playing more numbers
(more than the standard five, six, etc.), in a group, you have a better chance of having the officially drawn
numbers match your wheeled numbers. Second, by playing more tickets you increase the odds
mathematically of holding a cash paying ticket(s).

Probably the greatest single benefit of wheeling is the payoff maximization which is inherent in a
wheeling system. Because you are playing several combinations of the same numbers, when a few of
these numbers are selected they appear on your tickets in a shotgun fashion. 

Any professional gambler who is successful uses a wheeling system. The wheeling system concept
provides a methodology for playing numbers and provides payoff maximization through multiple tickets
wins. It is a matter of personal choice as to whether or not you want to play the lottery. However, if you
do play the lottery, wheeling systems represent the most intelligent way to play and win!

7.2 Adding a Wheeling System

Lotto Pro comes with a large selection of wheeling systems. However, you may want to experiment with
other systems.

A good resource for other other wheeling systems is the Lotto Genius web site, located at http:/ / www.

lottogenius.com. You can also order books with other wheeling systems from our affiliate partner, Amazon.
com.

http://www.lottogenius.com/
http://www.lottogenius.com/
http://www.amazon.com/exec/obidos/external-search?tag=thelottoplayersb&keyword=lottery&mode=books
http://www.amazon.com/exec/obidos/external-search?tag=thelottoplayersb&keyword=lottery&mode=books
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To add a wheeling system:

1. From the File menu, select New|Wheeling System.

2. Enter the number of numbers per ticket in the wheeling system in the Numbers Per Ticket box.

3. Enter the number of numbers in the wheeling system in the Total Numbers in Wheel box.

4. Enter the number of tickets in the wheeling system in the Number of Tickets box.

5. Enter the number of numbers guaranteed to match in the numbers match if box.

6. Enter the number of numbers needed to be correct in the numbers are correct box.

7. Enter the numbers for each ticket in the Tickets list. Use the Tab key to advance your cursor after
entering each number. Remember, the numbers you are entering are NOT the actual numbers you
will be playing. The numbers represent the order of substitution for the set of numbers you will be
playing.

8. Click the Save button.

9. Type a name for the new wheeling system in the File name box. Do NOT change the prefix (ASys
or FSys) or file extension (a.05 or a.06). For example, if ASysxxx.a06 is displayed in the File name
box, you should change the name to something like ASys021.a06. Abbreviated wheeling systems
have a prefix of ASys and a file extension of Axx. Full wheeling systems have a prefix of FSys and a
file extension of Fxx. The xx indicates what type of lottery game the system is for. For example, a
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file extension of A06 indicates an Abbreviated wheeling system for a Pick-6 game.

10. Click the Close button to close the New Wheeling System dialog.

Tip: 

If you discover that you have made a mistake after saving a wheeling system, you can edit the wheeling
system to make any needed corrections.

7.3 Editing a Wheeling System

If you add a new wheeling system and later discover that you made a mistake, you can edit the wheeling
system and make any needed corrections. Do NOT edit any of the wheeling systems that were supplied
with Lotto Pro.

Before you edit a wheeling system, make sure that you open the lottery that you will be playing with the
system. For example, if want to edit a wheeling system for the Florida Lotto, first open the Florida Lotto
drawing file. When you edit the wheeling system, only wheeling systems for Pick-6 games will be
displayed.

To edit a wheeling system:

1. From the Edit menu, select Wheeling System.

2. Select the wheeling system that you want to edit. Abbreviated wheeling systems have a file
extension of Axx. Full wheeling systems have a file extension of Fxx. The xx indicates what type of
lottery game the system is for. For example, a file extension of A06 indicates an Abbreviated
wheeling system for a Pick-6 game.

3. Click the OK button.
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4. Click on the ticket(s) that you want to change and enter the information. Use the Tab key to
advance to the next number.

5. Click the Save button to save your changes. The changes are saved to the file that you opened to
edit.

6. Click the Close button to close the Edit Wheeling System dialog.

7.4 Deleting a Wheeling System

You can delete wheeling systems that were supplied with Lotto Pro or that you have added.

The wheeling systems have file extensions that indicate what type of lottery game they are for. 
Abbreviated wheeling systems have a file extension of Axx. Full wheeling systems have a file extension
of Fxx. The xx indicates what type of lottery game the system is for. For example, a file extension of
A06 indicates an Abbreviated wheeling system for a Pick-6 game. A file extension of F05 indicates a
Full wheeling system for a Pick-5 game.
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To delete a wheeling system:

1. From the File menu, select Delete Wheeling System File.

2. Select the wheeling system that you want to delete.

3. Click the OK button. A confirmation message is displayed.

4. Click the Yes button to delete the file.
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8 Technical Support

8.1 Technical Support

Before contacting our support department, you should make sure that you have the latest version of
Lotto Pro.

You should also check the Frequently Asked Questions (FAQ) located at http://www.windowslotto.com/
faq.html

Contact information is available at http://www.windowslotto.com/contact_us.html.

http://www.windowslotto.com/faq.html
http://www.windowslotto.com/faq.html
http://www.windowslotto.com/contact_us.html
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